Special Effect #2 Tutorial

Collage Of Warped Photos

Robert Gellibolian (aka, Bladerunner001)

1. Select picture:
One that needs to be warped. | have chosen this one online.

2. Open in Photoshop (I use CS4)

3. Rename the background layer:
With the photo newly opened inside Photoshop, if we look over in the Layers palette, we
can see that we currently have one layer, named Background, which contains our image:
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We need to add a new blank layer below this Background layer, but there's a small
problem. Photoshop treats the Background layer differently from all other layers (which
is why the name is written in italics). There are things we can do with other layers that we
can't do with the Background layer. One of the things we can't do is add any layers below
it. The Background layer must always remain the bottom layer in the Layers palette.
Fortunately, there's an easy way around this problem. All we need to do is rename the
layer to something other than "Background", and the easiest way to do that is by holding
down your “Option” (Mac) key and double-clicking directly on the word "Background".
Photoshop will automatically rename the layer "Layer 0":
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4. Add a new blank layer below “Layer 0”:
Now that our Background layer is no longer named "Background", we can add a layer
below it. To do that, hold down your “Command” (Mac) key and click on the New Layer

icon at the bottom of the Layers palette:

=HE
Layers ‘Channels Y Paths \_ 0]
Normal v Opacity:| 100% *

lck: L 7+ @ Fill:  100% | *

i -

=000 5 )5

Clicking the "New Layer" icon adds a new blank layer, and by default, Photoshop places
new layers above the layer we currently have selected in the Layers palette, but by
holding down "Ctrl/Command" as we click on the icon, we tell Photoshop to place the new
layer below the currently selected layer. As we can see now in our Layers palette, the new
layer, which Photoshop has automatically named "Layer 1", appears below "Layer 0":
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5. Add additional canvas space around the image:
Since we're going to be bending and warping our image, we need to give ourselves a little
extra room to work, which means we need to add some extra canvas space around the
image. To do that, go up to the Image menu at the top of the screen and choose Canvas
Size. This brings up the Canvas Size dialog box. Enter 150 for the Width and Height and



change the measurement type for both to percent (you will have to play with this #
depending on size and resolution of picture). Make sure the Relative option is not
checked, and make sure the middle square is selected in the Anchor grid. Click OK when
you're done, and Photoshop will add the extra canvas space all around the image, giving
us lots of room to work:

. Add a white stroke to the image:

Double Click on "Layer 0" in the Layers palette. This brings up the Stroke dialog box. I'm
going to enter a value of 20 px (pixels) for my Width, which works well with my image
here. You may need to enter a different value depending on the size of the image you're
using. I'm using a low-resolution image for this tutorial, so if you're using a high-
resolution image, you'll need to try a higher width value. The goal here is to simply add
what looks like a standard white photo border around the image, which means we also
need to select white as our stroke color, so click on the color swatch to the right of the
word Color, which brings up Photoshop's Color Picker and choose white. Finally, set the
Location option in the middle of the dialog box to “Inside” so the stroke appears inside the
edge of the image. Click OK to exit out of the dialog box and apply the white stroke:

. Warp the image with Photoshop’s Warp tool:

Here's where we get to the fun part. We're going to bend, twist and curl the image using
Photoshop's Warp Tool. There's a couple of different ways to access the Warp Tool. One is
to go up to the Edit menu at the top of the screen, choose Transform, and then choose
Warp, but here's a faster way. Press “Command+T” (Mac) to bring up Photoshop's Free



Transform box and handles around the image, then simply click on the Warp icon in the
Options Bar at the top of the screen:
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You can click on that icon again at any time to switch back and forth between Free
Transform and the Warp Tool. With the Warp Tool selected, you'll see a 3x3 grid appear
over your image:

If you've never used the Warp Tool before, it may seem a little confusing at first, but the
easiest thing to do is simply play around with it and see what it does, since nothing you do
will actually be applied to the image as long as the Warp Tool remains active. In no time at
all, you'll see just how easy and fun the tool really is. To warp the image from any of the
corners, simply click on any of the square corner handles and drag it around with your
mouse. Here I'm dragging the top left corner outward:

To create a page curl, which is where the Warp Tool really shines, drag any of the corner
handles inward. If you drag the corner in far enough, you'll actually see what looks like
the back of the photo appearing in the corner (it's actually a mirror image of the photo,
but it still looks pretty cool):



You can also warp the image by dragging the round handles that extend out from the
corners:

Here's what my image looks like, with the Warp Tool still active, after I've reshaped the
image in a way that works for me (yours may look completely different):



When you're ready to accept your changes, press “Return” (Mac) to have Photoshop apply
them to the image

8. Duplicate the layer:
Now that we've warped the image, we need to duplicate it. To do that, with "Layer 0" (the

layer that contains our image) selected in the Layers palette, use the keyboard shortcut
“Command+]” (Mac) to duplicate the layer. If we look in the Layers palette now, we can
see the newly created copy of the layer, which Photoshop has named "Layer 0 copy",

above the other two layers:
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9. Fill the Original image on “layer 0” with black:
Click back on "Layer 0" in the Layers palette to select it. Press “Command” key and put a

selection around your image. fill it with black by going to “Edit/Fill...” and choose black as
the color:
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10.Create a drop shadow with the warp tool:
We're going to use the Warp Tool once again, this time to create a drop shadow effect for

our image using the area we just filled with black. With "Layer 0" still selected, I'm going
to access the Warp Tool the same way I did before, by pressing “Command+T” (Mac) to



bring up the Free Transform handles and then clicking on the Warp Icon in the Options
Bar. [ want the light to appear to be coming from the top left, which means my shadow
needs to appear along the bottom right of the image. So with my Warp Tool active, I'm
going to bend and reshape the black-filled area so it sticks out from under the right and
bottom of the image. Again, we're not going for absolute realism here, so feel free to
exaggerate things a little:

Press Return when you're done to accept and apply the changes.

Remember: this is working the layer you just filled with black (the drop shadow component)
and NOT the picture!!

11.Apply the Gaussian Blur filter to “Layer 0” (i.e., drop shadow layer):
We need to blur the edges of our shadow a little, so go up to the Filter menu at the top of
the screen, choose Blur, and then choose Gaussian Blur. When the Gaussian Blur dialog
box appears, I'm going to enter a Radius value of about 6 pixels to blur the edges of my
shadow slightly. Again, you may need to enter a higher value if you're using a high-
resolution image:
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12.Lower the opacity of this layer:
We've warped our shadow into shape with the Warp Tool and blurred out the edges, but

our shadow is much too intense at this point. To fix that, go up to the Opacity option in the
top right of the Layers palette and lower the layer's opacity to around 60%:
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Here's my image after lowering the opacity of the shadow:
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14.Change blend mode of new layer to “Hard Light” and lower opacity:
We need to change the blend mode of our new layer. To do that, go up to the Blend Mode
options in the top left corner of the Layers palette. By default, the layer is set to the
"Normal" blend mode. Click on the down-pointing arrow to the right of the word
"Normal"” and select Hard Light from the list:
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We're going to use this layer to paint in some highlights and shadows with Photoshop's
Brush Tool, but before we do, we need to lower the opacity of this layer quite a bit (see
above right image). We want very subtle highlights and shadows, so go over to the
Opacity option in the top right of the Layers palette and lower the opacity all the way
down to about 20% to start with. You may need to raise or lower it slightly when you're
done:

15.Load a selection around the image:
Before we begin painting, let's make sure we paint "inside the lines" so-to-speak, so we're
not painting over any of the transparent areas around the image. To do that, hold down
your “Command” (Mac) key and click directly on the preview thumbnail for "Layer 0
copy" (the layer that contains our image) in the Layers palette:
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16.Select the brush tool and paint with black to add some shadows:
First make sure that your image is selected (see #15). Select Photoshop's Brush Tool from
the Tools palette. With the Brush Tool selected and black as your foreground color, paint



over a few areas in the image to add subtle shadows, giving the image a bit more of a 3D
look to it. Resize your brush as needed by pressing the left bracket key on your keyboard
to make the brush smaller or the right bracket key to make it larger. To control the
hardness of the brush edges, hold down your Shift key and press the left bracket key a few
times to soften the edges, or hold down Shift and press the right bracket key a few times
to make the brush edges harder:

You can also “Control-click” (Mac) anywhere inside the document
to bring up the Brush Tool dialog box where you can adjust the
brush diameter and hardness with slider controls at the top:
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over is the area inside the selection. If
you make a mistake or you're just not
happy with how you painted over an area, either press “Command+Z” (Mac) to undo your
last brush stroke, or press E on your keyboard to switch to Photoshop's Eraser Tool, erase
over the mistake, then press B to switch back to your Brush Tool and continue painting.
Here's my image after painting in some shadows in the top left and right corners, as well
as over the page curl in the bottom right corner:

17. Optional: You can paint parts of the image with white to add highlights to the image:
You can essentially do the same as above (with white brush instead of black) to add
highlight to other parts of the image.



18.Group the 3 layers that make up the image:
We've completed our work on our first photo! All we need to do now is add it to our main
collage document (which we'll open in a moment). Right now, our image is made up of
three separate layers - the main image on "Layer 0 copy", the main shadow below it on
"Layer 0", and the highlights and shadows on "Layer 2" at the top. Rather than dragging
three separate layers into the main collage document, let's make things easier by
grouping the layers so all three of them will be placed inside a "folder" in the Layers
palette. That way, we can simply drag the folder over to the collage document instead of
dragging three separate layers. This will also make it easier to keep our main collage
document organized when we start adding additional photos to it.

To create the layer group, since "Layer 2" is currently selected in the Layers palette, hold
down Shift and click on "Layer 0". This will select both "Layer 0" and "Layer 0 copy" above
it while keeping "Layer 2" at the top selected, so all three layer will then be selected (in
previous versions of Photoshop, you would need to link the layers together rather than
selecting them like this):
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With all three layer selected, go up to the Layer menu at the top of the screen and select
Group Layers. Photoshop adds all three layers into a new group. If you look in your Layers
palette, you'll see that the three layers seem to have disappeared, replaced by a folder
icon with the name "Group 1" beside it. Double-click directly on the words "Group 1" and
rename the group something more descriptive like "Photo 1":

=[x =
- — Layers ‘Ghannels \Paths go)
rs  Channels { Paths Y ) -
Laye \ \ - &) Pass Through v Opacity:| 100% | *
Pass Th h Opacity: | 100% | *
zs5 Throug v pacity Lock: ] 7 4 @ 100%
Lock: L] &+ @ 100% | * § -
‘ B photo 1
-
> B Photo 1 it
o . Layer 2
\2
@ Layer 1 o '.;‘ : Layer 0 copy
= 9. 0O ®. 0 & 3 - . Layer0
o Layer 1
=2 B 0O ®» O & 3




19. With the new “blank” layer selected, Fill it with white...Pictures 10 & 11
The work on our first photo is done and we've organized the three layers that make up
the image into a layer group. All we need to do now is drag the layer group over to our
main collage document, so go ahead and open the image you want to use as your
background. Here's the image I'll be using:

20.Drag the “Group Layer” into the collage image:
With both images open in their own separate document windows on your screen, click
anywhere inside the document containing the photo we just finished working on so that
its document window is selected. Then, simply click on the layer group in the Layers
palette and drag the group into your background image document:



You'll see your photo appear in front of your background image in the new document, and
if you look in the new document's Layers palette, you'll see that the layer group has been
copied over to the new document and is now sitting above the Background layer:

=[]
Layers ‘Channels Y\ Paths N\ )
Pass Through v Opacity:| 100% | *
Lock: L] & @

B photo 1

Background a

= $ 0O ® 0 & 3

21.Resize and reposition the photo with free transform:
Now that our first photo is in front of the background inside the document we'll be using
for our collage, we can move and resize it as needed. To do that, press “Command+T”"
(Mac) to once again bring up the Free Transform box and handles around this image. To
move the photo with Free Transform, simply click anywhere inside the photo (except for
on the small target icon in the center) and drag the image into position with your mouse.
To resize the image, hold down Shift and drag any of the corner handles. Holding down
Shift as you drag constrains the width and height proportions of the image, maintaining
its original shape. To resize the image from its center, hold down “Option” (Mac) as you
drag (you can hold Shift as well to constrain the proportions and resize from the center at
the same time). You can also rotate the image if you want by moving your mouse cursor
just outside the Free Transform box and then clicking and dragging your mouse.

Here, I've moved my photo into the center of the document and I'm resizing it by dragging
the bottom corner handle inward:



22.Repeat the same steps to add additional images to the collage:
And with that, our first photo has successfully been warped into shape and added into our
collage! To add more photos, simply repeat the steps we've just worked through for each
additional photo, warping each one differently for variety. When you get to the part where
you add the layers into a layer group, name your new groups with successive numbers
("Photo 2", "Photo 3", "Photo 4", etc.), then simply drag them into the main collage
document, move them into place and resize them as needed with Free Transform.

['ve added two more photos to my collage, and if [ look in my Layers palette, I can see that
[ now have three layer groups, named "Photo 1", "Photo 2" and "Photo 3", above my
Background layer which contains my background image:
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If you want to move one photo on top of another in your collage, simply click on its layer
group in the Layers palette and drag it above the other photo's group to change the
"stacking order". Layers and layer groups that are higher in the Layers palette appear in
front of layers and groups below them.



